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These release notes highlight new functionality, enhancements, software and hardware dependencies, and
include upgrade instructions for the NetVanta Unified Communications product family. This document is to be
used in conjunction with product documentation and training for the preparation of new and existing software
installations and is intended for technical professionals who are providing support services for NetVanta Unified
Communications products.

For general product information, please visit ADTRAN's website at http://www.adtran.com.

CAUTION: ltis strongly recommended that the contents of this document be reviewed before any
installation or upgrade, no matter how familiar the installer is with the product, to ensure that
current installation and upgrade procedures are followed. These procedures could change from
release to release, including maintenance releases. Failure to follow the upgrade procedures in this
document could result in non-operational systems.

1 Summary of Changes

This section summarizes new functionality introduced in this NetVanta UC Server release, along with issues
resolved in each release and any release-specific actions that are required as part of upgrading. Each maintenance
release is identified separately. More detailed descriptions for major new functionality follow in Section 2 New
Functionality Details,. Internal tracking numbers are noted (for example, [12341).

For newly introduced functionality and issues resolved in previous major releases, please consult the release notes
or product documentation for the respective releases.

Where functionality or issues resolved do not apply to products in the product family, the applicable products are
noted (for example, [ECS, BAS, UCS)).

NOTE: Be sure to review all upgrade actions for all releases between your current release and the release and
your upgrade. Subsections of the sections below identify required actions, including information about client
upgrades.

1.1 Releases.4.3

Release 5.4.3 is @ minor maintenance release update of NetVanta UC Server. Release 5.4.3 extends all existing
functionality and adds support for required Heartbleed security updates for Polycom firmware.

Additional interoperation with ADTRAN products namely the NetVanta 7100, the TAgxx series and SBC Feature

Packs continue to be supported. ECS, BAS, UCS



http://www.adtran.com/

2 New Functionality Details

This section describes the new functionality introduced in this NetVanta UC Server release. Where functionality
or issues resolved do not apply to products in the product family, the applicable products are noted.

2.1 Release 5.4.3

Polycom Heartbleed Firmware Fix

In keeping with Polycom Security Bulletin CVE-2014-0160, NetVanta UC Server now provides and distributes the
required firmware to secure Polycom phones. This related to the vulnerability in OpenSSL which could allow a
remote attacker to expose sensitive data, possibly including user authentication credentials and secret keys,
through incorrect memory handling in the TLS heartbeat extension. [ECS BCS

Software fixes included from release 5.4.2

Tracking# Summary Description

UCS-1815 Conference Server Crashes Conference server intermittently fails under
heavy use due to threading issue.

UCS-1814 Application Service Restart When Deleting BLF When deleting a user that is currently
Monitored User monitored as a BLF by another phone, the
application services restart.

UCs-1791 ECS stops sending SIP traffic SIP Services may begin to use up too much
memory on systems with heavy use.

Note that all fixes from previous 5.x releases up to and including 5.4.x will also be included in release 5.4.3 Please
consult the specific 5.x release notes for details on issues resolved in those releases.

2.1.1  Upgrade Requirements

Prior to upgrading an existing NetVanta UC Server system, be sure that the hardware platform and operating
system software meet the minimum requirements; otherwise, you will not be able to upgrade the software.
Ensure that both client and server requirements are met. Refer to Section System Requirement 3.2 for

information.

CAUTION: Failure to preserve installed software release media properly could result in the inability
to rebuild a failed server at a later date. Copies of noncurrent software versions might not be readily
available from ADTRAN Technical Support or your reseller causing delays to support technicians
rebuilding failed servers.

2.1.2  Client Upgrade Actions

Client software MUST be upgraded for all users of the NetVanta UC Server system. More information on client
deployment techniques, including automated deployment can be found in Section 4.3, Installing or Upgrading
NetVanta UC Client Software.




CAUTION: Although some client software point releases may permit connections to the server it is
highly recommended that the client server versions be matched to ensure proper software
functionality and reliability . e.g. 5.4.3 client connection to 5.4.2 server versions

If the administrator has customized any of the system audio files (Data\System\CustomAnnouncements) and
not placed them in the custom announcements folder Data\System\CustomAnnouncements\English
(U.S.) Male, thenthe customized files MUST be copied from CustomAnnouncements.Backup folder.

CAUTION: Failure to copy or backup customized audio files will cause them to be overwritten
during the upgrade. Only audio file from this location (Data\System\CustomAnnouncements) will
be automatically copied to CustomAnnouncements.Backup during upgrades.

For upgrades of the ECS and BAS products, scripts MUST be run before and after upgrading to properly upgrade
phone configuration files. Any customizations to phone configuration files must be manually re-applied using the
information and backups made by the scripts. Refer to Section 4.2.2, Upgrading NetVanta UC Server from 4.6.x,
5.0.x and all 5.x.x Release, for more information on this procedure.

CAUTION: The SQL database instance for NetVanta UC Server MUST be backed up to ensure
proper recovery of failed systems. For instructions on backup and restore procedures, refer to the
Planning and Deployment Guide, available online at https://supportforums.adtran.com. Please
adjust backup procedures accordingly. Failure to do so could result in data loss or extended system
outages in the case of hardware or software failures.
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3 Installation Requirements

This section describes the environmental prerequisites required for the correct operation of NetVanta UC Server,
including operating systems, server/client platforms, messaging servers, and mail clients. In addition, it describes
any steps required prior to installing NetVanta UC Server software, including obtaining the license key.

3.1 Preserving Installation and Upgrade Media

If physical installation media (a CD or DVD) was received, please store this media in a safe place so that the
software can be reinstalled at a later date if necessary (for example, in the event of a hardware failure).

If the software was downloaded, please ensure that a separate copy of the installation media is made to CD or
DVD and this media is stored in a safe place so that the software can be reinstalled at a later date if necessary (for
example, in the event of a hardware failure). Do not store the downloaded media on the same physical disks as
the operational server as a single disk failure could cause this media to be permanently lost.

Ensure that if software upgrades are performed, new versions are also stored on separate media in a safe place.
Support personal could require a copy of the installation media to reinstall software at a later date.

CAUTION: Failure to preserve installed software release media properly could result in the inability
to rebuild a failed server at a later date. Copies of noncurrent software versions might not be readily
available from ADTRAN Technical Support or your reseller causing delays to support technicians
rebuilding failed servers.

3.2 System Requirements

3.2.12  Server Components

This section describes the required operating systems, hardware requirements, and third-party integration
platforms for the NetVanta UC Server server components. This applies to both upgrades and new installations. If
existing server hardware does not meet these requirements, it must be upgraded or migrated to new hardware
prior to upgrading to this release of NetVanta UC Server.

3.2.1.1  Operating Systems
The NetVanta UC Server server components support the following Operating Systems:

Microsoft® Windows™

e  Microsoft Windows Server 2008 R2 (x64)
o Foundation, Standard, Enterprise, and Data Center editions are supported.
o Deployment on Server Core or Hyper-V is not supported.

e  Microsoft Windows Small Business Server 2008 (x64)

The recommended deployment for optimal performance and reliability is to install NetVanta UC
Server on the additional Windows Server 2008 license that is part of the Premium Edition of
Windows Small Business Server 2008. NetVanta UC Server can also be installed on the Windows
Small Business Server 2008 platform with suitable hardware. Refer to Section 3.2.1.3, Hardware
Requirements, for more information.

e  Microsoft Windows Server 2008 (x86, x64)
o Foundation, Standard, Enterprise, and Data Center editions are supported.
o Deployment on Server Core or Hyper-V is not supported.




o Microsoft Windows Server 2003 R2 SP1, SP2 (x86)
o Microsoft Windows Server 2003 SP1, SP2 (x86)
o Microsoft Windows Small Business Server 2003 SP1 (x86)

Microsoft Hyper-v™

o Support for Server 2008R2
o Support for Server 2012

VMware vSphere™

e  VMware vSphere 4.1
e VMware vSphere 5.0

3.2.1.2 Deprecated Operating Systems (no longer supported as of 5.0.x)
e  Microsoft Windows XP SP2, SP3 (Professional) (x86)
e  Microsoft Windows Essential Business Server 2008 (x86, x64)
e  Microsoft Windows Small Business Server 2011 (x86, x64)

Other software platforms are not supported.

Installation of the server components into other virtualization environments (Virtual Server, , Virtual PC, Virtual
Box, etc.) is not supported in production deployments. Due to the real-time nature of telecommunications, audio
problems may be experienced in these environments. ADTRAN recommends using server operating system only
for all installations of NetVanta UC Server.

CAUTION: When using TAPI integrations, or other integrations requiring use of CTl drivers, please
review driver documentation for those products BEFORE proceeding with plans to use Windows
Server 2008 or Windows Server 2008 derived platforms (SBS 2008/2010) as the server platform for
those deployments.

3.2.1.3 Hardware Requirements

To install NetVanta UC Server, the server hardware platform must meet the minimum requirements in the
following table. The minimum requirements are for a minimal installation. The recommended requirements are a
guideline for more robust, reliable, and future-proofed systems.

Product engineering guidelines and recommendations should be consulted and followed for anything other than a
minimal installation (for example, installations with more than 25 users). Sizing of the server hardware is
dependent on the number of users, the traffic levels, and application services used. Selection of hardware should
also take into account such things as redundant power supplies, uninterruptable power supplies (UPSs), and
redundant disk arrays (for example, RAID) so that the end users’ needs and expectations are met, along with any
future growth requirements.

Consult TN102 UC Server Hardware Platform Recommendations and the Planning and Deployment Guide, available
online at https://supportforums.adtran.com, for more information on correctly selecting the hardware.
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Hardware Minimum Recommended

Component

Processor Intel Pentium Dual-Core (E2140) Intel Xeon Quad-Core (E5310)

RAM 4GB 4GB
4 GB on Windows Small Business Server 2003 6 GB on Windows Small Business Server
6 GB on Windows Small Business Server 2008 2008

Disk space 80 GB (usable space) 146 GB (usable space)
7200 RPM SAS-RAID10orRAID 5

3.2.2  Mail/Messaging Servers for Unified Messaging

NetVanta UC Server supports the following email servers for Unified Messaging:

e  Microsoft Exchange™ Server 2000, 2003 SP1 (requires service pack 1 or later), 2007**, 2010, SP1/Sp2 **

WARNING: ** Changes in the Exchange Mailbox detection logic for connecting to Microsoft
Exchange Server 2010 or 2007 when the Exchange Mailbox, Client Access, and Hub Transport do not
reside on the same server may require disconnecting and re-connecting the mailbox to ensure
proper connectivity to the server in this configuration after an upgrade.

e IBM® Domino™ Server 6.0.%, 6.5.%, 7.0, 8.0 (via IMAP)

e Google Mail (via IMAP using stunnel)

e  University of Washington IMAPd

e Any 100 percent compliant IMAP4revi (RFC 3501) message store (different servers could require different
query optimization techniques — consult product documentation for query optimization technique
determination procedures)

Integration with Microsoft Exchange Server requires a MAPI connector to be installed on the NetVanta UC Server
platform. The supported MAPI connectors, of which only one should be installed on the server platform, are the

following:

e  Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1

(Version: equal or greater than 6.5.8165.0, 2010-Apr-28 — older versions are not compatible with all

platforms).This is available for download free of charge from:

http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-

0a110307611e&displaylang=en

e  Microsoft Outlook™ 2003 SP3 only

CAUTION: Microsoft Outlook 2003 as a MAPI connector is not supported and will cause unreliable
integration with Microsoft Exchange Server 2010 and could cause system outages.

e  Microsoft Outlook 2007 SP1 only

CAUTION: Outlook 2007 SP2 is not compatible as a server MAPI connector with UC Server and
installing it will cause NetVanta UC Server to be unable to connect to Exchange Server.
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e  All Microsoft Exchange 2010 integrations are only supported with MAPI Client and Collaboration
Data Objects1.2.1

CAUTION: Outlook 2010 is not compatible as a server MAPI connector with UC Server and
installing it will cause NetVanta UC Server to be unable to connect to Exchange Server.

ADTRAN recommends using Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 instead
of Microsoft Outlook and strongly encourages all customers to switch to this MAPI connector instead of Outlook.
The benefits of doing this are as follows:

e No Outlook license is required for the NetVanta UC Server system. The MAPI/CDO package is available
at no charge.

e The MAPI/CDO package is a minimal installation that requires fewer Microsoft Updates.

e This component is designed and provided by Microsoft explicitly for the purpose of allowing applications
such as NetVanta UC Server to access Exchange Server and does not include many of the client-side
nuances of Outlook versions of MAPI.

On Exchange Server 2003, additional steps are required after following the manual integration instructions in
Appendix A of the Configuration Guide:

Delegate Exchange View-Only Administrators control to the NetVanta UC Server service account:

Open Exchange System Manager on an Exchange Server in the enterprise, or an administrative workstation.
Select the enterprise level object (the root object in the tree).

Select Delegate control... from the Action menu. This will open the Exchange Administration Delegation
Wizard.

Click Next.

In the Users or Groups page of the wizard, click Add to open the Delegate Control dialog box.

Select the role Exchange View Only Administrators from the list of roles.

Click Browse... and select the service account used by NetVanta UC Server for Exchange Server and network
integration.

8. Click OK in the Select Users, Computers or Groups dialog box.

9. Click OKin the Delegate Control dialog box.

10. Click Next in the Users or Groups page of the Exchange Administration Delegation Wizard.

11. Click Finish to complete and close the wizard.
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3.2.3 Client Components

This section describes the required operating systems and hardware requirements for the NetVanta UC Server
client components. Most installations will deploy client software to some or all of the end users of the system.
Some installations do not require deployment of the client software depending on how NetVanta UC Server will
be used.

3.2.3.1  Operating Systems
The NetVanta UC Server client components (NetVanta UC Client, NetVanta ucCompanion, and NetVanta
ucCompanion - Live Attendant) support the following Microsoft® Windows™ Operating Systems:

e Microsoft Windows 7 (Professional, Ultimate, or Enterprise Editions) (x86, x64)

e  Microsoft Windows Vista, SP1, SP2 (Business, Ultimate, or Enterprise Editions) (x86, x64)
e  Microsoft Windows XP SP2, SP3 (Professional or Tablet PC Editions) (x86)

e Microsoft Windows Server 2008 R2 (x64)




e  Microsoft Windows Server 2008 (x86, x64)
e  Microsoft Windows Server 2003 R2, SP2 (x86)
e  Microsoft Windows Server 2003 SP1, SP2 (x86)

Other software platforms are not supported.

3.2.3.2  Prerequisite Components
Client components now requires a minimum version of Microsoft .NET Framework 4.0 to be installed on target

systems. In addition, for some components additional Microsoft redistributable components will be installed by
the client installer.

3.2.3.3 Hardware Requirements
To install NetVanta UC client, the platform must meet the following minimum requirements for the specified
Microsoft Windows operating systems listed below.

Client XP, Server 2003 Vista, Windows 7, Server 2008,
Server 2008 R2

Processor x86 compatible processor x86 or x64 compatible processor
600 MHz or higher 1 GHz

RAM 1GB 1GB

Free Disk space 5oo MB 5oo MB

Video Super VGA (800 x 600) or higher Support for DirectX g graphics with:
resolution video adapter and monitor e WDDM Driver

e Minimum 128 MB graphics
memory
e Pixel Shader 2.0 in hardware

e 32 bits per pixel

3.2.3.4 Email Clients for Unified Messaging
NetVanta UC Client integrates with the following email clients for Unified Messaging:

e  Microsoft Outlook 2002/XP, 2003 SP3 and 2007

e  Microsoft Outlook 2010 32/64 bit

e  Microsoft Outlook 2013 64 bit Standard/Professional/Plus
e |BM Lotus Notes™ 6.0x, 6.5.%, 7.0, 8.0

CAUTION: Click To Run (virtualized) versions of Office 2010/13 which include Outlook 2010/2013
are not compatible as plugin requirements are not distributed with these versions at this time.
This includes Home & Student/Home & Business Office 2013 and Office 365 editions.

Only volume licensed and .msi installed media can support the requirements for Office Plug-ins
and UC Client software.

3.3 Product Licensing (License Key)

All NetVanta UC Server products must be correctly licensed to operate. The license key obtained from ADTRAN is
specific to each installation and defines the exact functionality licensed by the end user for their installation.
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3.3.1  New Installs

When installing NetVanta UC Server for the first time, you must obtain a license key to install and activate the
software.

3.3.2 Upgrades

To upgrade NetVanta UC Server from a previous major or minor release, you must obtain a new license key prior
to beginning the upgrade. The existing license key, found in the License Information dialog box in the
administrative NetVanta UC Client must be updated to the new license key prior to beginning the upgrade. After
the new key is installed, you can continue to upgrade the server software. You do not need a new license key for
maintenance (patch or dot) releases.

Upgrade license keys are only available to customers who have an active Software Assurance subscription.

3.3.3 Obtaining a New License Key

To obtain a new or upgrade a license key;, fill out a license key request in the UC Tools area of the ADTRAN
website (http://www.adtran.com/uctools).

Note: Please allow enough time to obtain the license key — at least one (1) business day should be allocated to
ensure the license key is obtained before installation or upgrade.

You will need the following information:

Contact information
Product Keys
e New installs: available from materials that shipped with the product.
e Upgrades: available for a user with Administrator privileges. From NetVanta UC Client, select the Help
menu > License Information.
3. Purchase key
e New installs: available from materials that shipped with the product.
e Upgrades are available:
e  Forauser with Administration privileges: From within NetVanta UC Client, select the Help > License
Information. Click Modify license.
e  From the Product Licensing Wizard dialog box from Step 1 of NetVanta UC Server Configuration
Wizard.
4. Machine D
¢ New installs: available from the Product Licensing Wizard dialog box of Step 1 of the NetVanta UC Server
Configuration Wizard.
e Upgrades are available:
e  Fora user with Administration privileges: From NetVanta UC Client, select the Help > License
Information. Click Modify license.
e  From the Product Licensing Wizard dialog box of Step 1 of NetVanta UC Server Configuration
Wizard.
5. Platform specifications (CPU speed, RAM, and server OS) — available from the System control panel in the
Windows Control Panel.
6. Product version and edition you will be installing or upgrading — available from the materials shipped with the
product.
7. Message store type (Microsoft Exchange Server, Lotus Domino/Notes, IMAP4, or local machine) and version.
8. Legacy PBXinterconnection, if applicable: PBX type, firmware version.
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3.4 Prerequisite Components

NetVanta UC Server requires that prerequisite components be installed prior to installing the NetVanta UC Server
software. The installer will detect which components are missing from the system and prompt accordingly. Some
of the prerequisite components are included on the distribution media and can be installed automatically by the
installer. However, others must be obtained directly from the vendor. Links to the relevant web-sites for any
components that require downloading will be provided by the installer.

Not all prerequisites are required on all operating systems; specifics are noted below. Except where indicated, the
prerequisites are installed automatically by the installer. The prerequisite components are:

e  Microsoft .NET Framework 4.0 (download link provided in installer)

e Windows Server 2008 Enhanced Desktop Feature (a reboot is required after installation) [Windows
Server 2008-based systems only pre-requisite Microsoft Windows Server 2008 Roles and Features]

e *Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (Version: 6.5.8165.0,
2010-Apr-28 - older versions are not compatible with all platforms

e Microsoft Visual C++ 2005 SPa Redistributable Package (x86/x64)

e Microsoft Visual C++ 2008 SP1 Redistributable Package (x86/x64)

e Microsoft SQL Server 2008 Express Edition

e ADTRAN Software Diagnostic Logging Tools

*MAPI Client and Collaboration Data Objects pre-requisite used for integration with Exchange.

CAUTION: NetVanta UC Server will only work correctly with the version of Microsoft SQL Server
that is provided on the distribution media. Other instances of SQL Server cannot be used by
NetVanta UC Server.




4 Installation and Upgrade Instructions

Please review Section 3 Installation Requirements before proceeding with this section. It contains important
information about product licensing, system requirements, and the versions of required external software
components.

CAUTION: Failure to comply with the installation requirements, or properly follow the installation
or upgrade instructions will result in an inoperable or poorly performing system.

4.1 New Install of NetVanta UC Server

This section contains an overview of the installation for NetVanta UC Server; for detailed installation procedures
consult the Installation Guide applicable to your NetVanta Unified Communications product. To facilitate
installation and configuration, have the following reference material available during installation:

e Release Notes (this document)

e  Planning and Deployment Guide

e |Installation Guide

e NetVanta Unified Communications Server Presence and Control Components Guide (for use with
NetVanta ucCompanion - Live Attendant)

e Configuration Guide

e  Administrator Manual

e NetVanta ucCompanion Desktop Presence User Guide

To ensure that all the required information is available during the installation and configuration process, it is
recommended that the Planning and Deployment Guide Worksheet be completed.

4.1.1  Installing the Server Software

The installation software will automatically verify the prerequisites for software installation. Make sure that you
run the installation from a Windows logon that has the ability to install software on the NetVanta UC Server
system (for example, Administrator privileges).

To install NetVanta UC Server:

1. Ifthe NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the
NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on NetVanta UC Server (you
will need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear).

b. Insertthe NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN
NetVanta Unified Communications CD menu will appear.

Install the applications to the NetVanta UC Server platform by clicking on the Install Server button on the
installation screen and following the prompts on the subsequent screens.

a. Ensure that all prerequisites are installed. These will vary depending upon your platform and the
components purchased, such as the Presence and Control components and the Windows 2003
Server Administration Tool Pack. The NetVanta UC Server Installation Wizard will ensure that all
prerequisite components are installed before proceeding.

b. Afterall the prerequisite components are successfully installed, the wizard allows you to install the
NetVanta UC Server software.

2. Runthe NetVanta UC Server Configuration Wizard, Configure UC Server. The NetVanta UC Server
Configuration Wizard allows you to specify server properties such as message store, NetVanta UC Server
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administrator password, PBX information, and dialing properties. The wizard guides you through the server
configuration process. The wizard does most of the configuration tasks automatically, however, site specific
information about the network and server needs to be entered at various steps.

3.  Wheninstalling NetVanta UC Server for the first time, you must obtain a license key. To obtain a license key,
please refer to Section 3.3, Product Licensing (License Key).

4.1.2 Installing the Client Software

In order for NetVanta UC Server users to take full advantage of its functionality, client software should be
deployed to their desktop or laptop computers. Refer to Section 4.3, Installing or Upgrading NetVanta UC Client
Software, for installation options and procedures.




4.2 Upgrading NetVanta UC Server

CAUTION: Backup procedures have changed from previous releases. For instructions on backup
and restore procedures, refer to the Planning and Deployment Guide, available online at
https://supportforums.adtran.com, and adjust backup procedures accordingly. Failure to do so could
result in data loss or extended system outages in the case of hardware or software failures.

4.2.1  Upgrade Matrix

The following table describes which versions of NetVanta UC Server can be upgraded to newer versions.

To 5.0.X 5.1.X 5.2.X 5.3.X 5.4.X
(NetVanta UC | (NetVanta UC | (NetVanta UC | (NetVanta UC | (NetVanta UC
Server) Server) Server) Server) Server)
From
4.6.x (deprecated) Direct Direct Direct Direct
upgrade upgrade upgrade upgrade
(SNetVanta uc v unsupported unsupported unsupported unsupported
erver) —upgrade to —-upgrade to —-upgrade to —-upgrade to
5.0.X 5.0.X 5.0.X 5.0.X

5.0.X
(NetVanta UC v v v v
Server)
5.1.X
(NetVanta UC v v v
Server)
5.2.X
(NetVanta UC v v
Server)
5.3.X
(NetVanta UC v
Server)
5.4.X
(NetVanta UC
Server)

In order to upgrade from older versions, interim upgrade steps must be followed. Refer to the applicable section
below for more details.



https://supportforums.adtran.com/

4.2.2  Upgrading NetVanta UC Server from 4.6.%, 5.0.x and all 5.x.x Releases

CAUTION: The existing version of NetVanta UC Server must NOT be uninstalled prior to
upgrading. The installation process requires that the existing implementation be available in order
to perform the upgrade correctly.

The following is a summary of the upgrade procedure from any NetVanta UC Server 4.6.x/5.0.x releases; refer to
the Installation Guide applicable to your NetVanta Unified Communications product, available online at
https://supportforums.adtran.com, for detailed instructions on installing this component.

CAUTION: Failure to follow the steps below, exactly as described, could result in a system that does
not upgrade or operate correctly after upgrade.

Perform the following steps:

1. If performing a major or minor upgrade, obtain a new license key. Please refer to the instructions in Section
3.3, Product Licensing (License Key).

2. Backup the NetVanta UC Server. For instructions on backup and restore procedures, refer to the Planning and
Deployment Guide applicable to your NetVanta Unified Communications product, available online at
https://supportforums.adtran.com. Backing up will preserve the following data:

Users (greetings, services, announcements)

Port configuration

Attendant data

System configuration

Routing data

Telephone data

Gateway data

PBX configuration data

SO ho a0 T o

CAUTION: Failure to backup the data according to these instructions and the Technical Note will
result in the inability to restore the system to the original configuration should the upgrade process
be unsuccessful or aborted. Always back the system up prior to upgrading.

3. Ifanewlicense key was obtained in Step 1, modify the current license key using the following procedure:
a. Open NetVanta UC Client using the current installed product version and log in as a user with
administrative privileges.
Select License Information... under the Help Menu on the main toolbar.
Click the Modify license... button to open the Modify License dialog box.
Enter the new license key in the space provided.
Click OK to close the Modify License Dialog box.
Click Close to close the License Information Dialog box.
g. Close NetVanta UC Client by clicking the top right corner x icon or selecting Close from the File menu.
4. Ifthe NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the
NetVanta UC Server CD-ROM was shipped to you, go to Step b.
a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will
need to provide a location and name for the folder).
b. Insert the NetVanta UC Server CD-ROM. The CAAutoRun application will start, and the ADTRAN
NetVanta Unified Communications CD menu will appear — leave this open for now, you will use it later.
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5. For ECS and BAS product variants, run the Pre-Update .bat script file as follows:
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Click the Start menu and select Run...
Type cmd. exe and click OK to open a command prompt window

NOTE: On systems with User Account Control (UAC) enabled, such as Windows Server 2008 R2, you
must start the command prompt window as Administrator. To do this, instead of Step a and Step b
above, do the following:

Click on the Start menu.
Type cmd. exe in the search bar. (If classic start menu is enabled, locate Command Prompt under
All Programs | Accessories instead.)

3. Rightclick on cmd.exe in search results (or Command Prompt in the menu), and select Run as
administrator.

4. Accept the UAC prompt to elevate the command prompt to administrative privileges.

Navigate to the script folder on the installation media using the cb command. This is located in the
Utility\Scripts subfolder of the installation media.

Example: CD /d C:\NetVantaUCServerInstallMedia\Utility\Scripts
Run the Pre-Update.bat script, supplying any appropriate parameters relevant to your installation:

Syntax: Pre-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder]

e If your NetVanta UC Server installation is not located at C: \Program
Files\ADTRAN\NetVanta UC Server), you must specify the location of the PhoneTypes
system data folder as shown in the example below.

o If backups should be written to a location other than C: \Backup\PhoneTypes, then you
must specify a backup folder as shown in the example below.

e The /2 option provides help on the script; the /v option provides more detailed output and
logging.

Example: Pre-Update.bat "C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\"

When the script prompts you to continue, confirm the information displayed, type ¥, and then press
Enter.

Examine the output of the script to ensure it ran correctly. The output is placed in a file called
Pre-Log.txt in the backup location. The default backup location is C: \Backup\PhoneTypes.
Leave the command window open because it will be used later.

The ADTRAN NetVanta UC Server Application Services service could be unable to be started during the
upgrade due expiry of the service account password. This can also occur spontaneously on some Windows XP
installations or in networks where account passwords have to be changed regularly, but will not be detected
until the machine is restarted or the ADTRAN NetVanta UC Server Application Services service is restarted.
Be sure to have the service account password accessible in order to reset it immediately.

To verify that the service account password has not expired, do the following:
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Open the Services administration tool from Start > Control Panel > Administrative Tools.

Locate the service named ADTRAN NetVanta UC Server Application Services.

Right click on the service, and select Restart from the context menu.

If the service fails to start, right click on the service, and select Properties from the content menu.
Select the Log On tab. Re-enter the service account password in the provided fields and click OK.
Attempt to start the service again by right clicking on the service, and selecting Start from the context
menu. If the service again fails to start, verify that the service account is operating correctly and is not
locked out.




10.

11.

12.

IMPORTANT NOTICE: Failure to perform this step will cause the install to fail with a 1920 error if
there is a problem with the service account or its password. This can be corrected by following the
same steps while the 1920 error is displayed. Do not cancel the 1920 error dialog box because it will fail
to upgrade and your system will have to be restored from backups. When you have corrected the
service account password, click Retry in the 1920 error dialog box.

If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the

NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Locate the temporary folder where you extracted the files in a previous step. Start the upgrade by double
clicking on CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear).

b. Fromthe ADTRAN NetVanta Unified Communications CD Menu (opened when the CD was inserted in a
previous step), click the Install Server button to prepare the NetVanta UC Server upgrade.

On an upgrade from previous releases, you could be required to install or update prerequisite components.

Click on the Verify or automatically install remaining components button to proceed. Some components

might require downloading from the vendor’s websites.

Adding the NetVanta UC Server Presence and Control Components:

a. Ifyouare using the NetVanta Unified Communications Server product variant, or if you do not plan on
using NetVanta ucCompanion - Live Attendant:

e  Disable the following option: Install Presence Components.

e  Click Next.

b. If you plan on upgrading the Presence and Control Components from a 4.6.x or 5.0.x version you must
first uninstall the existing version via Add/Remove control panel applet:

e  Navigate to the install media and locate the ADTRAN NetVanta ucCompanion.msi and launch the
installer and follow the dialog box.

e  (lick Install on the ADTRAN NetVanta UC Live Attendant Server Components Setup Wizard
screen.

e  Click Next on the welcome page of the ADTRAN NetVanta UC Live Attendant Server
Components Setup Wizard and follow the prompts on subsequent screens until finished. Consult
the NetVanta Unified Communications Server Presence and Control Components Guide for additional
installation documentation.

e  C(lick Finish when complete.

e  Click Yes when prompted to restart the system for the configuration changes to take effect.

Upgrading the NetVanta UC Server.

If upgrading 5.x:

e  The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear briefly
as the upgrade does various checks on the system.
e  Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified
Communications Server Setup Wizard appears and follow the prompts to complete the upgrade.
e  Click the Finish button to close the setup wizard and return to the Preparing NetVanta UC Server
Installation dialog box.
Click the Configure UC Server button to launch the NetVanta UC Server Configuration Wizard.

NOTE: If all the steps in the server configuration were completed prior to the upgrade, you will be presented with
three options (Change Service Account, Users, and Phone Types). You could be required to perform the first
option, Change Service Account to reset the service account to what was configured prior to the upgrade.

For ECS and BAS product variants, run the Post-Update.bat script file as follows:
a. Locate the command window opened in Step o.
b. Runthe Post-Update.bat script, supplying any appropriate parameters relevant to your installation:




Syntax: Post-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder]

e If your UC Serverinstallation is not located at C: \Program Files\ADTRAN\NetVanta UC
Server)\, you must specify the location of the PhoneTypes system data folder as shown
below in the example.

o If backups were written to a location other than C: \Backup\PhoneTypes, then you must
specify the same backup folder as specified in Step o.

e The /2 option provides help on the script; the /v option provides more detailed output and

logging.

Example: Post-Update.bat "C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\"

c.  When the script prompts you to continue, confirm the information displayed, type Y, and then press
Enter.

d. Examine the output of the script to ensure it ran correctly. The output is placed in a file called
Post-Log.txt in the backup location, which defaults to C: \Backup\PhoneTypes.

e.  When the script completes, it will indicate if any site-specific customizations have been made. Details of
the customizations will be output to a file called FileComparison. txt in the backup location. The
default backup location is C: \Backup\PhoneTypes.

f.  The Post-Update script will only update all of the “attributes.xml” files for each phone type in use. It will
not modify any other files automatically. Please re-apply any necessary custom configuration to all other
files listed in “FileComparison.txt”. For any questions or concerns, please refer to phone vendor
documentation or contact ADTRAN support for guidance. Once any customizations have been re-
applied, restart the ADTRAN NetVanta UC Server Application Services service using the Services
administrative tool.

IMPORTANT NOTICE: For upgrades of ADTRAN phone family types, custom configurations
will be lost unless the following changes are made prior to running the Pre-Update.bat

e Locate the ADTRAN.original.zip on the release media

e  Extract to the following location: "C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\ADTRAN

e Runthe Pre-update and Post-update instructions as noted below

IMPORTANT NOTICE: Since some phone firmware required for supporting new features in this
release have changed, the following phone family types including Polycom and snom's existing
user customized configuration files (.cfg) will be overwritten during an upgrade and cannot be
merged as a result of the post-update script execution as noted above. Custom configuration will
require user to edit the new .cfg files after the upgrade and associated phone firmware revision
update.

13. Update the RestartOverrides.cfgfile (locatedin..\NetVanta UC Server\Data\System\Recovery\)
according to the following conditions:
a. If manual changes have been made to this file, then you must manually copy any entries from
RestartOverrides.cfg.original to RestartOverrides.cfgthatare not presentin the latter file.
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14.

15,

16.

b. If no manual changes were made to this file, then replace the contents of RestartOverrides.cfg with
the contents of RestartOverrides.cfg.original. Itis not necessary to restart the ADTRAN
NetVanta UC Server Application Services service. However, if the file has been appended to instead of
being replaced, then the application service must be restarted for the changes to take effect.

If Install Presence Components was selected in Step 9, you will be required to configure these components

at this time. Please consult the NetVanta Unified Communications Server Presence and Control Components

Guide for configuration documentation. If this is an upgrade from 4.6.x or 5.x, then the NetVanta UC Server

Presence and Control Components could have already been configured.

For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please

refer to Section 3.7, Configuring Services, of the Installation Guide.

For ECS and BAS product variants, re-apply phone configurations to all phones in the system as follows:

a. Open NetVanta UC Client and log in as a user with administrative privileges.

b. Click on the Administration navigation bar.

c. Click onthe Phones folder in the Administration navigation bar.

d. Inthe contents pane, select all phones by clicking on the first phone, then pressing Shift-Ctrl-End on the
keyboard. All phones should now be selected.

e. Rightclick on one of the selected phones, and select Reload Configuration from the menu. This will
cause all phone configuration files to be regenerated and phones to reload their configuration data
(rebooting most phone types).

To install NetVanta UC Server:

1.

Rename all of the configuration files in the . \Data\System by appending . old to the existing filename:

Example: C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\DefinityPBXDefinition.cfgtoDefinityPBXDefinition.cfg.old

If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the

NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will
need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a
copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade
Media.

b. Insertthe NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta
Unified Communications CD menu will appear.

If you plan on using NetVanta ucCompanion — Live Attendant, install or update the NetVanta UC Server

Presence and Control components at this time. Consult the NetVanta UC Server Presence and Control

Components Guide for installation documentation, which is provided on the distribution media.

Install the server applications to the NetVanta UC Server platform by clicking on the Install UC Server

buttons on the NetVanta UC Server installation screen and following the prompts on the subsequent screens

until finished.

For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please

refer to Section 3.7, Configuring Services, of the Installation Guide.

Once the installation has completed, select the Configure UC Server button to run the Server Configuration

Wizard, but do not add anything if it has already been configured. From the set of options, at a minimum,

complete the following tasks:

a. Enterthe NetVanta UC Server license key to enable SIP functionality.

b. Configure the Windows Network Integration and select from one of the following:
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i. If the service account was previously configured for Local System account, you must create a
Windows account on the local machine. Operating the Application Services service on the Local
System account is no longer supported.

ii. If the service account was previously configured with a Windows Active Directory™ account, then
configure the Existing Service Account.

7. Open the Windows Services application and ensure that the ADTRAN NetVanta UC Server Application
Services service is set to start automatically. Note, you might have to refresh (F5) the services application in
order to get a current view of the status. From the Windows Services Applications, start the ADTRAN
NetVanta UC Server Application Services service if it is not already started.

8. Complete the remaining steps in the NetVanta UC Server Configuration Wizard. If appropriate, make any
additional configuration changes required, such as adding NetVanta Enterprise Communications Server as a
new communication system, adding new phone types or new gateways.

4.2.3  Upgrading Client Software

If anything other than a minor server upgrade has taken place, client software must be updated on end user
computers; only 5.1.x client software is supported with 5.1.x server software. Refer to Section 4.3, Installing or
Upgrading NetVanta UC Client Software, for installation options and procedures.

4.3 Installing or Upgrading NetVanta UC Client Software

This section documents manual installation procedures, and presents other techniques for automated client
deployment.

CAUTION: Only release 5.4.x NetVanta UC Client software is compatible with NetVanta UC Server
5.4.x software (the patch revision value 'x’ does not need to be identical). All incompatible clients
must be upgraded after the NetVanta UC Server has been upgraded.

4.3.1  Manual Installation or Upgrade Instructions

NOTE: The user installing NetVanta UC Client software MUST have administrative privileges on that desktop
computer.

1. Ifthe NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the

NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on the desktop computer (you will
need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a
copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade
Media.

b. Insert the NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta
Unified Communications CD menu will appear.

2. Install the client applications to the client computer by clicking on the Install Client button on the installation
screen and following the prompts on the subsequent screens.

CAUTION: Installing NetVanta UC Client directly on the NetVanta UC Server platform is not
supported. Ensure that the client is installed on a separate platform meeting the minimum
requirements.
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4.3.2  Other Techniques for Installing and Upgrading Client Software
Client software can be deployed using automated techniques including:

e GPO-based MSl installation. Refer to TN116 - NetVanta UC Server - Installing NetVanta UC Client Using
GPO, available online at https://supportforums.adtran.com, for more information on this option.

e GPO-based login scripts that invoke either SETUP . EXE or MSIEXEC . EXE with appropriate parameters.
Prerequisite components must have been previously installed successfully. Consult standard Microsoft
documentation for more information on those techniques.

5 Support, Documentation, and Training

5.1  Support

Self-service support material can be obtained from the ADTRAN website, http://www.adtran.com/support, and

from the ADTRAN Technical Support Knowledge Base, https://supportforums.adtran.com.

Information on product support services can be obtained from the ADTRAN website:
http://www.adtran.com/support.

5.2 Documentation

Product documentation and additional technical support material can be found on the ADTRAN website,
http://www.adtran.com/support, and in the ADTRAN Technical Support Knowledge Base,

https://supportforums.adtran.com.

5.3 Training

Information on current training programs and certifications can be found on the ADTRAN website:
http://www.adtran.com/training.

5.4 Product Downloads and Third-Party Drivers

Product downloads and third-party drivers and patches are available in the support area of the ADTRAN website:
http://www.adtran.com/support.
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6 ADTRAN IP phones and Polycom Phone Interoperability

Phone Firmware BootRom | Filename Polycom ADTRAN
Model supported supported
SPIP 301 3.1.8 4.1.4 2345-11300-010.sip.Id | Yes No
SPIP501(2) |3.1.8 4.1.4 2345-11500-030.sip.ld | Yes No
3.1.8 4.1.4 2345-11500-040.sip.Id | Yes No
SPIP 600 3.1.8 4.1.4 2345-11600-001.sip.Id | Yes No
SPIP 601 3.1.8 414 2345-11605-001.sip.Id | Yes No
SSIP 4000 3.1.8 4.1.4 2201-06642-001.sip.Id | Yes No
SPIP 430 3.2.5 43.1 2345-11402-001.sip.Id | Yes No
SPIP 320 (2) 3.3.2 4.3.0 2345-12200-002.sip.Id | Yes No
3.3.2 43.0 2345-12200-005.sip.Id | Yes No
SPIP 330 (2) 3.3.2 4.3.0 2345-12200-001.sip.Id | Yes No
3.3.2 4.3.0 2345-12200-004.sip.Id | Yes No
SSIP 5000 4.0.5 5.0.5 3111-30900-001.sip.Id | Yes No
SSIP 6000 4.0.5 5.0.5 3111-15600-001.sip.Id | Yes No
SSIP 7000 4.0.5 5.0.5 3111-40000-001.sip.Id | Yes No
SPIP 321 4.0.5 5.0.5 2345-12360-001.sip.Id | Yes Yes
SPIP 331 4.0.5 5.0.5 2345-12365-001.sip.Id | Yes Yes
SPIP 335 4.0.5 5.0.5 2345-12375-001.sip.Id | Yes Yes
SPIP 450 4.0.5 5.0.5 2345-12450-001.sip.Id | Yes No
SPIP 550 4.0.5 5.0.5 2345-12500-001.sip.Id | Yes Yes
SPIP 560 4.0.5 5.0.5 2345-12560-001.sip.Id | Yes No
SPIP 650 4.0.5 5.0.5 2345-12600-001.sip.Id | Yes Yes
SPIP 670 4.0.5 5.0.5 2345-12670-001.sip.Id | Yes No
VVX 300 4.1.6 5.1.6 3111-46135-002.sip.Id No Yes
VVX 310 4.1.6 5.1.6 3111-46161-001.sip.Id | No Yes
VVX 400 4.1.6 5.1.6 3111-46157-002.sip.ld No Yes
VVX 410 4.1.6 5.1.6 3111-46162-001.sip.Id | No Yes
VVX 500 4.1.6 5.1.6 3111-44500-001.sip.ld No Yes
VVX 600 4.1.6 5.1.6 3111-44600-001.sip.Id | No Yes
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Phone Firmware BootRom | Filename Polycom ADTRAN
Model supported supported
VVX 1500 4.0.5 5.0.5 2345-17960-001.sip.Id | Yes No

SL 8440 4.0.2B N/A 3111-36150-001.sip.Id | Yes No

SL 8450 4.0.2B N/A 3111-36152-001.sip.Id | Yes No

SL 8452 4.0.2B N/A 3111-36154-001.sip.Id | Yes No
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7 ADTRAN Gateway Interoperability

CAUTION: Multiple ADTRAN gateway firmware releases are available for deployment during the
product lifecyle. Proper interoperation is typically only guaranteed with a specfic firmware version
at the time of UC product release. This is the known working firmware as of this release.

Gateway Vendor Model Firmware Number UC Server version
ADTRAN Total Access 916e R10.9.3 5.4.3.8216
ADTRAN Total Access 924e R10.9.3 5.4.3.8216
ADTRAN NetVanta 6242 R10.9.3 5.4.3.8216
ADTRAN NetVanta 6355 R10.9.3 5.4.3.8216
ADTRAN NetVanta 7100 — (BCS) R10.9.3 5.4.3.8216
ADTRAN NetVanta 644 R10.9.3 5.4.3.8216
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8 Third-Party Interoperability

CAUTION: Some third-party drivers and applications may not support Windows Server 2008 and
derived platforms (SBS 2008, 2010). When using TAPI integrations, or other integrations requiring
the use of CTl drivers, please review driver documentation for those products BEFORE proceeding
with plans to use Windows Server 2008 as the server platform for those deployments.

Please consult information provided in TNog1 — UC Server Interoperable SIP Devices and Services, available online
at https://supportforums.adtran.com, for interoperability information related to:

e S|P telephone terminals
e SIP soft phones
e SIP paging speakers, amplifiers and related devices
e  SIP wireless terminals
e SIP gateways and application layer gateways (ALGs)
e |TSPs
Information on PBX integration and software applications is provided below in this document.

8.1 NetVanta UC Server with a PBX Integration

8.1.1  Supported Private Branch Exchanges (PBX)

NetVanta Unified Communications Server has the capability to connect to multiple traditional PBXs and IP PBXs
while simultaneously supporting SIP services . NetVanta UC Server can be deployed as a voicemail, unified
message server, database IVR platform, and fax server behind a traditional PBX while also simultaneously
supporting SIP telephony . This provides a useful transition strategy for companies looking to migrate to
VolIP but who still want to leverage their existing infrastructure. NetVanta UC Server users who employ a
traditional PBX for telephony can still take advantage of Active Directory™ integration for user management; the
telephony features will be managed through their PBX configuration interface.

NetVanta UC Server integrates with a wide variety of traditional PBX and IP PBXs using Dialogic 12000 and 2000
Media Gateways. The following PBXs are now supported using the Dialogic Media Gateway:

e  Alcatel Omni PCX 4400 e Nortel CS-1000

e Avaya Communications Manager e Nortel DMS 10

e Avaya Definity G3 e Nortel DMS 100

e Avayalegend e Nortel Meridian 1

e Avaya Merlin Magix e  Phillips Sopho

e Avaya Partner e Rolm (Siemens) 8ooo
e  Ericsson BusinessPhone e Rolm (Siemens) gooo
e  Ericsson MD11o e Rolm (Siemens) 9751
e Intecom PointSpan M688o e Siemens HiCom 150E
e Mitel 3300 e Siemens HiCom 300
e Mitel SX-2000 e Siemens HiPath 4000
o  Mitel SX-200D Family e Toshiba CTX

e NECNEAX2400
For more specific details on which PBX editions and interfaces are supported, consult the Dialogic Media Gateway
documentation available from Dialogic’s website: http://www.dialogic.com/support/helpweb/mg/integration.htm.
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NetVanta UC Server also integrates with the PBXs listed in the table below using one of the following techniques:

e Analog port integration with in-band tones using Dialogic® D/4PCIUF and D/120JST-LS Media Boards
¢ Digital set emulation using Dialogic® D/82JCT-U and D/42JCT-U PBX Integration Boards

e (Tllink/analog port integration using Dialogic® D/4PCIUF and D/120JST-LS Media Boards

e PBXVendor supplied Microsoft TAPI/WAVE Service Providers

PBX Minimum Technical Note | Integration Type Third-Party
Vendor/Model Software (TN) Reference Hardware/Software
Release Number (Recommended)
Avaya 1.0 and above TNo16 Digital set emulation: Dialogic 6.0 SU 269
Communications - 7434D emulation
Manager - 8434D emulation
- 7434ND emulation
Avaya Definity 6.3 and above TNoog Analog port using Dialogic 6.0 SU 269
(no CLID) mode codes; mode
code option is required
Avaya 4.0 and above TNo1o Digital set emulation: Dialogic 6.0 SU 269
Definity/Multi- - 7434D emulation
Vantage - 8434D emulation
(with CLID) -7434ND (7.5 and
above)
Avaya IP Office 2.0 and above TNo12 CTl link/analog port - IP 400 CTl link
using TAPI - IP 400 TAPI-WAVE
Dialogic 6.0 SU 229
Avaya Merlin 3.1and above Analog port using Dialogic 6.0 SU 229
Legend mode codes
Avaya Merlin 2.1 and above TNoo8 Analog port using Magix CTI link bundle
Magix mode codes Dialogic 6.0 SU 229
(with CLID)
Avaya Merlin 2.1and above TNoo8 CTllink/analog port Dialogic 6.0 SU 229
Magix using mode codes
(no CLID) [TSAPI
Avaya Partner ACS | 3.0 and above Analog port using Dialogic 6.0 SU 229
mode codes
Cisco Call Manager | 4.2 TNo39 Cisco-supplied
Microsoft TAPI/WAVE
Service Provider
Mitel SX200 G1005/LW16 TNo11 Analog port using Dialogic 6.0 SU 229
(family) F41.0.2 enhanced in-band

DTMF tones
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PBX Minimum Technical Note | Integration Type Third-Party

Vendor/Model Software (TN) Reference Hardware/Software

Release Number (Recommended)
Mitel 3300 (IVR Any version that Analog port using Dialogic 6.0 SU 229
only) requires ONS in-band DTMF tones

voicemail support

Nortel Norstar 4.2 and above TNoo3 Digital set emulation: Dialogic 5.1.1 with
- M7324 set emulation | PTR.31016 **

Generic in-band PBX dependent Analog port using Dialogic 6.0 SU 229
in-band DTMF tones

** NetVanta UC Server ONLY supports Dialogic Release 5.1.1 software with PTR.31016 (LIBFAXMT.DLL) for
Norstar PBXs since the Do Not Disturb feature does not work with Dialogic Release 6.0 for Nortel Norstar PBX.

8.1.2 New Installation of Dialogic Software
To install Dialogic software on the new NetVanta UC Server:

1. Install the Dialogic System Software compatible with the PBX make and model.
a. Run SETUP.EXE from Windows Explorer.
i. When prompted to select features, select Core Runtime Package, select Next.

ii. When advised that the installation will install third-party software, select Yes. The installation will

detect and remove any existing Dialogic system software.
iii. The first stage of the installation will require a reboot. When prompted to restart the system,
select Yes.
2. Verify through the Windows Hardware Device Manager that all of the Dialogic cards reside in the Dialogic
Springware Devices section.

NOTE: If any of your cards appear to be improperly configured (for example, caution symbol or otherwise) then
you will have to update the driver.

a. Toupdate the driver:
i. Locate and configure the Dialogic card from Device Manager.
ii. Select the Driver tab and select Update Driver.
iii. Choose Search for suitable driver for my device (recommended), and click Next.
iv.  When the driver update locates the Dialogic Card, click Next.
b. Repeat Stepithrough Step iv for each Dialogic card that appears improperly installed or configured.

3. Run Dialogic Configuration Manager (Start > Programs > Dialogic System Release > Configuration Manager

—DCM. DCM will detect any Dialogic hardware installed on the machine hosting NetVanta UC Server
software.
a. Ensure that the board settings match your PBX type. (The default configuration is Nortel Norstar.)

b. Fordigital set emulation, open each card and ensure the MISC tab > PBXSwitch parameter is configured

according to your integration.
c. Referto the relevant configuration guide
4. Configure the Dialogic service to start automatically; Select Settings > System Device Autostart to Start

System. It is normal to encounter the error message Failed to set the Device Autostart setting. Requested

data not found in NCM data storage.
5. Proceed with NetVanta UC Server installation instructions.
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6. Verify the Dialogic board ordering by running NetVanta UC Client as an administrator and call each port. If
the ports are not answering in the correct order, switch the Dialogic cables on the back of the machine
hosting NetVanta UC Server software.

8.1.3 Toupgrade Dialogic software on existing NetVanta UC Server (if required)

Once you have determined that the Dialogic software version needs to be upgraded then perform the following
steps:

1. Remove existing Dialogic system software.

a. Stop the existing NetVanta UC Server and Dialogic services.

b. Launch the Microsoft Windows Service control application (Start > Settings > Control Panel >
Administrative Tools > Services).

i. Stop the service labeled ADTRAN NetVanta UC Server Application Services and change the
service Startup type from Automatic to Manual.

ii. Stop the service labeled Dialogic System Service.

c. Remove the Dialogic System Software.

i. Locate the Add/Remove Programs from the Windows Control Panel (Start > Settings > Control Panel

> Add/Remove Programs).
ii. Select and Remove the Dialogic software.
d. Reboot the system as indicated.

2. Inrareinstances, you might need to run a Dialogic utility to clean up the old Dialogic Release 5.1.1 installation
files, directories, and registry settings. This batch file can be located in \cleanup\dlgc rel clean.batin
the Dialogic installation directory. This will be apparent if the Dialogic DCM — configuration management
application is not installed.

3. Install the Dialogic System Software.

a. Follow the procedure in the previous section (New Installation of Dialogic Software) to install the required
version of Dialogic applicable to your PBX.

4. Launch the Microsoft Windows Service control application (Start > Settings > Control Panel > Administrative
Tools > Services).

a. Setthe Startup type to Automatic for the service labeled ADTRAN NetVanta UC Server Application
Services.

8.2 Software Product Interoperability

The following other software products have been tested and are known to work with NetVanta UC Server:

Vendor Interoperability Product/Service Software Version
Level
Blackberry (BBRY) | Interoperable BlackBerry Enterprise Server 4.10r newer

for Microsoft Exchange

BlackBerry Handheld Devices 4.2.1rev 163, 4.2.2 Or newer

PhoneTag Interoperable PhoneTag n/a
(formerly SimulScribe)

Google Interoperable Google Mail (Gmail) n/a
using stunnel (SSL proxy) stunnel 4.24 or newer
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9 Known Software Limitations

The following limitations are known in this NetVanta UC Server release:

Tracking  ISSUE Workaround
#
UCS-1764  Service editor crashing Quick element manipulation can at times cause this failure.
Restart the editor for continued operation
UCS-1763  Application service fails to Reduce client connections to server
restart (after restart request by
watchdog due to CallHandler)
UCS-1736  UC Wizard Phone Types Still None not service affecting
Refers to "Connect Plus
Product" as well as descriptive
text
UCS-1701  UC User Migration Wizard - Enable the global catalog on the child domain. This is disabled by
Cannot locate global catalog for  default on creation of a child domain
child domain
UCS-1689 UCdoes not respond to an Contact ADTRAN Support. This issue is specific to TAgxx
INVITE with hold SDP gateways running particular firmware revisions
UCS-1669 Third Party (VVX None, although this was determined to be gateway specific
300/400/500/600) - EFK Call
Recording stop key does not
work for external calls
UCS-1656 Inconsistent display of UC Client  None not service affecting
icons in Metro on Windows
8/Server 2012
UCS-1653 PowerShell sample reports do None not service affecting
not run on Windows 8/Server
2012
UCS-1652  Incorrect graphic in UC Client on  None not service affecting
Windows 8/Server 2012
UCS-1649 ucCompanion won't allow new  Recreate the identity for the user and reconcile the entry by
authentication username restart he application service via services.msc
UCS-1641  ucCompanion Live Attendant None not service affecting
Softphone does not
accommodate SIP Error
conditions with prompt server
disabled
For more information on other “Known software limitations” please refer to the associated release notes for
the specific release (e.g. 5.4.x/5.3.x releases)
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